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Chapter 1

What is GeoGebra?

GeoGebra is a mathematics software that joins geometry, algebra and calculus. It is developed
by Markus Hohenwarter at the University of Salzburg for mathematics education in schools.

On the one hand, GeoGebra is a dynamic geometry system. You can do constructions with
points, vectors, segments, lines, conic sections as well as functions and change them dynamically
afterwards.

On the other hand, equations and coordinates can be entered directly. Thus, GeoGebra has
the ability to deal with variables for numbers, vectors and points, finds derivatives and integrals
of functions and offers commands like Root or Extremum.

These two views are characteristic of GeoGebra: an expression in the algebra window corre-
sponds to an object in the geometry window and vice versa.



Chapter 2

Examples

To get an impression of GeoGebra’s possibilities, let's have a look at some examples.

2.1 Triangle with angles

e At first, choose the modBew point(see3.2) in the toolbar and click three times on the
drawing pad to create the three vertices A, B and C of the triangle.

e Select the mod@olygonand click on the points A, B, C and again A to create the triangle
P. In the algebra window the area of the triangle is shown.

e To get all the angles of our triangle, choose the mAdglein the toolbar and click on the
triangle.

Now, choose thdovemode and drag the vertices to change the triangle dynamically. If you
don’t need the algebra window and coordinate axes, hide them by usinvgethenenu.

2.2 Linearequationy=kx+d

We concentrate on the meaning of k and d in the linear equatierkz + d by trying different
values for k and d. To do this we might enter the following lines in the input text field at the
screen’s bottom (press enter at the end of each line).

k
d

y

o
~ N

x +d

Now we can change k and d in the algebra window (right click: "Edit") or in the input text
field
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You can change k and d very easily with the arrow keys (animatidng? or sliders (right
click on k or d, Show Object; se22.1Q.

In a similar way we might investigate the equations of conic sections sueh @+ /b =
1, %% + a®y? = a?b? or (x — m)? + (y — n)? = r%

2.3 Centroid of three points A, B, C

We are now going to construct the centroid of three points by entering the following lines in the
input text field (press enter at the end of each line). Of course, you can also use the mouse to do
this construction using the modes ($28) in the toolbar.

A= (2, 1)

(5, 0)

(0, 3)

= Midpoint[B, C]
= Midpoint[A, C]
Line[A, M_a]
Line[B, M_Db]
Intersect[s_a, s _b]

B =
C =
M_a
M_b
S_
S_
S

a

b

Alternatively we compute the centroid directly as
S1=A+B+C)/3

and compare both results using the command

Relation[S, S1]

Subsequently we experiment whetliee= S1 is true for other positions of A, B, C as well.
We do this by choosing the move mode with the mouse (leftmost button in the toolbar) and
dragging one of the points.

2.4 Splitline segment AB ataratioof 7 : 3

As GeoGebra allows us to calculate with vectors, this is an easy task.

A= (2, 1)
B = (3, 3)
T=A+710 B - A
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Another way of doing this could be

A= (2 1)
B = (3, 3)
v = Vector[A, B]
T=A+ 710 v

In a next step we could introduce a number t (e.g. by using a sBd&d,Q and redefine the
point TasT = A + t v (see3.1.7). By changing t you can see T moving along a straight
line.

This line could be entered now in parameter form &&e3:

g X =T+ sv

2.5 Set of linear equations in two variables

Two linear equations in x and y can be interpreted as two straight lines. The algebraic solution is
the intersection point of these two lines.

g:3x + 4y = 12
h:y=2x-8
S = Intersect[g, h]

You can both change the equation (right click, edit) and move or rotate the line with the
mouse Move 3.2.1 Rotate 3.2.])

2.6 Tangent to a function of x

GeoGebra offers a command for the tangent to a function f(x) at x=a.

3
= 2 sin(x)
Tangent[a, f]

a
f(x
t

— 1l

By animating a (sed.1.2 the tangent slides along the graph of f.
Another way of doing this would be

a=3
f(x) = 2 sin(x)
T = (a f(a))

t: X =T+ s (1, (@)

Additionally, we get the point T on the graph of f. The tangent t is given in parametric form.
By the way, you can create the tangent of a function geometrically too:
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e Choose the moddew point(see3.2) and click on the graph of the function f.
e Choose the modéangentsand click on the function f and then on the point created before.

Now, choose théVlove mode and drag the point along the function with your mouse. The
tangent is changed dynamically too.

2.7 Investigation of polynomial functions

With GeoGebra you can investigate roots, local extrema and inflection points of polynomial
functions.

f(x) = x*3 - 3 x2 + 1
N = Root[f]

E = Extremum]f]

W = InflectionPoint[f]

In Move mode you can drag the function f with the mouse. In this context, the first two
derivatives of f are interesting too.

Derivative|[f]
Derivative[f, 2]
2.8 Integrals

To introduce integrals GeoGebra offers the possibility to visualize lower and upper sums of a
function as rectangles.

f(x) = x"2/14 + 2

a=2~0

b =2

n=>5

L = LowerSum[f, a, b, n]
U = UpperSum[f, a, b, n]

By chaning a, b or n (animatior.1.2 slider, 3.2.10Q you can see the influence of these
parameters. For the increment of n you should select 1 (right click on n, properties).
The definite integral can be shown as follows:

Integral[f, a, b]
The antiderivative F is created using:

F = Integrallf]
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Geometric input

Now we will explain how the mouse is used in GeoGebra.

3.1 General notes

The geometry window (to the right) shows points, vectors, segments, polygons, functions, straight
lines and conic sections graphically. Whenever the mouse is moved over an object a description
appears. The geometry window will be calldé@wing padsometimes.

There are several modes to tell GeoGebra how it should react to mouse input (new point,
intersect, circle through three points, ...). This aspect will be explained in detail3a®gr (

Double click an object in the algebra window to open its editing field.

3.1.1 Context menu

Right-clicking on an object yields a context menu where you can choose the algebraic notation
(polar or cartesian coordinates, implicit or explicit equation, ...). Here you also find commands
like Rename , Edit or Delete .

Choosing Properties shows a dialog window, where you can change colour, size, line thick-
ness, line style, filling etc.

3.1.2 Show and hide

Geometric objects can be drawn (show) or not (hide). Use the i@bde/hide Objeqt3.2.1) or
the context menu3(1.]) to change this state. The icon left to every object in the algebra window
tells us about its current visibility state.

3.1.3 Trace

Geometric objects can leave a trace on the screen when they are moved. Use the context menu
(3.1.1) to switch this trace on or off.

10
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The menu itenRefresh Viewm the Viewmenu clears all traces.

3.1.4 Zoom

After right clicking on the drawing pad a context menu appears that let's you zoom in or out. See
also modegoom in(3.2.1) resp.Zoom out(3.2.]).
Zoom window: right click and drag the mouse to zoom a specified rectangle.

3.1.5 Axes Ratio

Right click on the drawing pad the get a context menu where you can change the ratio between
x-axis and y-axis.

3.1.6 Construction Protocol

The interactive construction protocol (mekiew) is a table that shows all construction steps.
Here you can redo a construction step by step. It is even possible to insert construction steps and
change their sequence. You can find more details in the construction protocol’s help menu.

3.1.7 Redefine

An object may beaedefinedusing its context menuw3(1.1). This is very useful for subsequent
changes of your construction. You can also openReédefinalialog by double clicking on a
dependent object.

In order to place a free point A onto a line h, chod®edefindor the point A and enter
Pointfh] . To remove the point from this line and make it free again, redefine it to some free
coordinates liké3,2)

Another example is the conversion of a line h through two points A and B into a segment:
chooseRedefinand entelSegment[A, B]

Redefining objects is a very versatile tool to change constructions width hindsight. Please
note that this may also change the order of the construction steps in the construction protocol

(3.1.6.

3.2 Modes

The following modes can be activated in the toolbar or@@metrymenu. Click on the small
arrow right to an icon to get a menu with other modes.

To mark an object means tolick on it with the mouseln all construction modes you can
easily create new points by clicking on the drawing pad.
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3.2.1 General Modes
Move

Drag and drop free objects with the mouse.
Select an object by clicking on it in move mode; then you may

e delete it by pressing the Del key
e move it by using the arrow keys (sd€l.2

Hold the Ctrl-key to select several objects.

Rotate around point

Select the center point of the rotation first. Afterwards you may rotate free objects around this
point by dragging them with the mouse.

Relation

Mark two objects to get information about their relati@n3.1).

Move drawing pad

Drag and drop the drawing pad to move the origin of the coordinate system.
You can also move the drawing pad by pressing the Ctrl key and dragging it with the mouse.

Zoom in

Click on any place of the the drawing pad to zoom in (8@e

Zoom out

Click on any place of the the drawing pad to zoom out (38e

Show / hide object

Click on an object to show resp. hide it. All objects that should be hidden are highlighted. Your
changes will be applied as soon as you switch to any other mode in the toolbar.

Show / hide label

Click on an object to show resp. hide its label.
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Copy visual style

This mode lets you copy visual properties like colour, size, line style, etc. from one object to
several others.

At first, choose the object whose properties you want to copy. Afterwards click on all other
objects that should adopt these properties.
Delete object

Click on any object you want to delete.

3.2.2 Point
New point
Clicking on the drawing pad creates a new point. Its coordinates are fixed when the mouse button
is released again.
By clicking on a segment, straight line or conic section you create a point on this object.
Clicking on the intersection of two objects creates this intersection point.
Intersect two objects
The intersection points of two objects can be produced in two ways.

1. Mark two objects: all intersection points are created (if possible)

2. Click on an intersection of the two objects: only this single intersection point is created

For segments, rays or arcs you may specify whether you wailaw outlying intersection
points(properties3.1.7). This can be used to get intersection points that lie on the extension of
an object. For example, the extension of a segment or a ray is a straight line.

Midpoint
Clicon...
1. two points to get their midpoint.

2. one segment to get its midpoint.

3. a conic section to get its center.

3.2.3 \ector
Vector between two points

Mark start- and endpoint of the vector.
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Vector from point

Mark a point A and a vector v to create the point B = A + v and the vector from A to B.

3.2.4 Segment
Segment between two points

Marking two points A and B fixes a segment between A and B. In the algebra window you see
the segment’s length.

Segment with given length from point

Click on a point A that you want the segment to start from. Specify the desired length a in the
appearing window.

This mode will create a segment with length a and the endpoint B of this segment. The
endpoint B may be rotated Movemode around the starting point A.

3.2.5 Ray
Ray through two points

Marking two points A and B creates a ray starting at A through B. In the algebra window you
see the equation of the corresponding line.

3.2.6 Polygon
Polygon

Mark at least three points and then click the first point again. In the algebra window you see the
polygon’s area.

3.2.7 Line

Line through two points

Marking two points A and B fixes a straight line through A and B. The line’s direction vector is
(B-A).

Parallel line

Marking a line g and a point A defines a straight line through A parallel to g. The line’s direction
is the direction of g.
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Perpendicular line

Marking a line g and a point A yields a straight line through A perpendicular to g. The line’s
direction is equivalent to the perpendicular vectbB(H of g.

Line bisector

The line bisector of a line segment is stated by a segment s or two points A and B. The line’s
direction is equivalent to the perpendicular vectbB(5 of the segment s resp. AB.

Angular bisector

Angular bisectors can be defined in two ways.

1. Marking three points A, B, C produces the angular bisector of the enclosed angle, where
B is the apex.

2. Marking two lines produces their two angular bisectors.

The direction vectors of all angular bisectors have length 1.

Tangents

The tangents to a conic can be produced in two ways:
1. Marking a point A and a conic ¢ produces all tangents through A to c.
2. Marking a line g and a conic ¢ produces all tangents to c that are parallel to g.

Marking a point A and a function f produces the tangent line to f in x=x(A).

Polar or diameter line

This mode creates the polar resp. diameter line of a conic section:
1. Mark a point and a conic section two get the polar line.

2. Mark a line or a vector and a conic section two get the diameter line.

3.2.8 Conic Section
Circle with center through point

Marking a point M and a point P defines a circle with center M through P. This circle’s radius is
the distance MP.
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Circle with center and radius

After marking the center point M you are asked for the radius in a window.

Circle through three points

Marking three points A, B, C defines a circle through these points. If the tree points lie on one
straight line, the circle degenerates to this line.

Conic through 5 points

Marking five points produces a conic section through them. If no four of these five points lie on
a line, the conic section is defined.

3.2.9 Arc and Sector

The algebraic value of an arc is its length, the value of a sector is its area.

Semicircle

Marking two points A and B produces a semicircle above the segment AB.

Circular arc with center through two points

Marking three points M, A and B produces a circular arc with center M, starting point A and
endpoint B. Note: point B does not have to lie on the arc.

Circular sector with center through two points

Marking three points M, A and B produces a circular sector with center M, starting point A and
endpoint B. Note: point B does not have to lie on the sector.

Circumcircular arc through three points

Marking three points produces a circular arc through these points.

Circumcircular sector through three points

Marking three points produces a circular sector through these points.



3.2. MODES 17

3.2.10 Number and Angle
Distance

This mode yields the distance of ...
1. two points
2. two lines

3. apointand a line

Slider

Click on any free place on the drawing pad to create a slider for a number or an angle there. The
appearing window lets you specify the interval [min, max] of the number resp. angle and the
width of the slider (in pixel).

In GeoGebra a slider is nothing but the graphical representation of a free number resp. angle.
You can easily create a slider for any existing free number resp. angle by showing this object
(right click and choosshow objedt

The position of a slider may be absolute on the screen or relative to the coordinate system
(see properties of the corresponding number or adgle)).

Angle

This mode creates ...
1. the angle between three points
2. the angle between two segments
3. the angle between two lines
4. the angle between two vectors
5. all interior angles of a polygon

All these angles are limted between 0 and“1B0size. If you want taallow reflex angles
choose the appropriate setting in the properties die8ah ).

Angle with given size

After marking two points A and B a window appears where you are asked for the angle’s size.
This mode produces a point C and an anglevherea = Z(ABC).
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3.2.11 Locus
Locus

First mark a point Q whose locus should be drawn. Afterwards click on a point P that Q depends
upon. Note that the point P has to be a point on an object (line, segment, circle, ...).

3.2.12 Geometric Transformations
The following geometric transformations work for points, lines, conic sections, polygons and for
images.

Mirror object at point

At first, mark the object to be mirrored. Afterwards click on the point that should be the mirror.

Mirror object at line

At first, mark the object to be mirrored. Afterwards click on the line that should be the mirror.

Rotate object around point

At first, mark the object to be rotated. Then click on the point that should be the rotation center.
Afterwards a window appears where you may specify the rotation angle.

Translate object by vector

At first, mark the object to be translated. Afterwards click on the translation vector.

Dilate object from point

At first, mark the object to be dilated. Then click on the point that should be the dilation center.
Afterwards a window appears where you may specify the dilation factor.

3.2.13 Text
Text
With this mode you can create texts 8fgX formulas.
1. Clicking on the drawing pad creates a new text at this location.

2. Clicking on a point creates a new text whose position is relative to this point.

Afterwards, a dialog appears where you may enter the text. It is also possible to use object’s
values and thus create dynamic texts.
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Input | Description

"This is a text” simple text

"Point A =7 + A dynamic text using the value of point A

"a ="+ a+ "cm’ dynamic text using the value of segment a

The position of a text may be absolute on the screen or relative to the coordinate system (see
properties of the texB.1.1).

ATEX Formulas

In GeoGebra you can also write formulas. To do so set the check box fgé formula in
the dialog of the text mode and enter your formula®iEX syntax. Here, some importarfxX
commands are explained. Please have a look atd@gy documentation for further information.

IATEX input Result
a \cdot b a-b
\frac{a}{b} 7
\sqrt{x} NG
\sqrt[n]{x} V'
\vec{v} 0]
\overline{AB} AB
xN2} x?
a._{l} ai
\sin\alpha + \cos\beta sin v + cos 3
\int_{a}*b} x dx [P wda
\sum_{i=1}{n} "2 o i?

3.2.14 Images
Insert image
This mode lets you add an image to your construction.
1. Clicking on the drawing pad specifies the lower left corner of the image.
2. Clicking on a point specifies this point as the lower left corner of the image.

Afterwards, a file-open dialog appears where you may choose the image file to insert.

3.2.15 Properties of Images
Position

The position of an image may be absolute on the screen or relative to the coordinate system (see
properties of the image3.1.1). The latter is achieved by specifying up to three corner points.
This gives you the flexibility to scale, rotate and even distort images.
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e 1. Corner: position of the lower left corner of the image.

e 2. Corner (lower right): this corner may only be set if the 1. Corner was set before. It
controls the width of the image.

e 4. Corner (upper left): this corner may only be set if the 1. Corner was set before. It
controls the height of the image.

Lets create three points A, B and C to explore the effects of the corner points. Set A as the
first and B as the second corner of your image. By dragging A andawe mode you can
explore their influence very easily. Now set A as the first and C as the fourth corner. Finally, you
could set all three corner points and see how you dragging the points distorts your image.

You already saw how to influence the position and size of your image. If you want to attach
your image to a point A and set its width to 3 and its height to 4 units, you could do the following:

e 1. Corner: A

e 2. Corner: A+ (3,0)

e 3. Corner: A+ (0,4)

When you drag point A ilMovemode now, your image keeps the desired size.
See comman@orner(4.3.13.

Background Image

You may set an image to be in tihackground(properties of the image3.1.1). A background
image lies behind the coordinate axes and cannot be selected with the mouse any more.
In order to change the background setting of an image, cHoagpertiesfrom theEdit menu.

Transparency

An image can be made transparent in order to see images or axes lying behind it. You can set the
transparency of an image by specifyinglang value between 0% and 100% (properties of the
image,3.1.1).
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Algebraic input

We will now explain how the keyboard is used to make input in GeoGebra.

4.1 General notes

Values, coordinates and equationgreeanddependentbjects are shown in the algebra window
(on the left hand side). Free objects do not depend on any other objects and can be changed
directly.
Input can be made in the input text field at the bottom of the screen. This will be explained
in detail later 4.2and4.3).

4.1.1 Change values

Free objects can be changed, dependent objects can’t. To manipulate a free object’s value, over-
write it by entering the new value in the input text fieltl2).
Alternatively, this can be done in the algebra window by choosing Edit in the context menu

(3.1.1).

4.1.2 Animation

To change a number or angle continuously select move n®@el), click on the number or
angle and press the + or - key.

Keeping one of these keys pressed lets you produce animations. For example, if a point’s
coordinates depend on a number k likéPm(2k, k) , the point will move along a straight line
when k is changed continuously.

With the arrow keys you can move any free object in move mode. The increment is adjustable
in the properties dialog3(1.]).

e Ctrl + arrow key ... 10 * step width

e Alt +arrow key ...100 * step width

21
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A point on a line can also be moved along its line using the + or - key.

4.2 Direct Input

GeoGebra can treat numbers, angels, points, vectors, segments, lines and conic sections. We will
now explain how these objects can be entered through coordinates or equations.

You can also use indices within the names of objedisresp. s, is entered as\_1 resp.
s {AB} .

4.2.1 Numbers and angles
Numbers and angles use the sigas decimal point.
numberr|r = 5.32
Angles are entered in degreg ¢r radian (rad). The constapt is useful for radian values.

| degree | radian
angle alphd alpha = 60 ° | alpha = pi / 3

GeoGebra does all internal calculations in radian. The symisahothing but a constant for

15 10 convert degree into radian.

Sliders and Arrow Keys

Free numbers and angles can be displayed as sliders on the drawing pa@ (5@eBy means
of the arrow keys you may change numbers and angles in the algebra window tdal(Qee

Limit Value to Interval

Free numbers and angles may be limited to an interval [min, max] (propestied). This
interval is also used for sliders (sieBe.10.

For every dependent angle you can specify whether it may become reflex or not (properties,
3.1.0.

4.2.2 Points and Vectors

Points and vectors may be entered in cartesian or polar coordida®ed.( Upper case labels
denote points, lower case labels vectors.

\ cartesian coordinatqspolar coordinates
pointP | P = (1, 0) P=1(; 0°
vectorv| v = (0, 5) v = (5; 90 ©°)
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4.2.3 Line

A line is entered as a linear equation in x and y or in parametric form. In both cases previously
defined variables (numbers, points, vectors) can be used. The line’s name has to be entered at the
beginning of the input followed by a colon.

| equation | parametric form
lineg|g: 3 +4y =2 |g: X =(5 5 +1t(4 -3

Let bek=2 andd=-1 for example. Then we can define a line g by entering the equgtion
y =kx+d.

XxAXxis und yAxis

The two coordinate axes are available in commands using the nefwes andyAxis . For
example, the commanerpendicular[A, xAXis] constructs the perpendicular line to
the x-axis through a point A.

4.2.4 Conic Section

A conic section is entered as a quadratic equation in x and y. Previously defined variables (num-
bers, points, vectors) can be used. The conic section’s name has to be entered at the beginning
of the input followed by a colon.

equation

ellipse ell ell : 92 + 16y° = 144
hyperbola hyp hyp : 922 — 16y* = 144
parabola par | par:y? = 4x

circle k1 kl:2%+9y*=25

circle k2 k2:(z—5)*+ (y+2)? =25

Let bea=4 andb=3 for example. Now we can enter an ellipse as éiz? + a%y? = a?b%.

4.2.5 Function of x

To enter a function you can use previously defined variables (numbers, points, vectors, ...) and
other functions.

| Input
Function f f(x) = 32° — 22
Function g g(x) =tan(f(x))

nameless Function sin(3z) + tan(z)
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All'internal functions (like sin, cos, tan, etc.) are described in the section about arithmetic
operations4.2.9.

There are commands to get the integf&)(and derivatives4.3.1] of a function. You can
alsousd’(x) ,f'(x) ,f'(x) ,...forthe derivatives of a previously defined function f(x):

f(x) = 32 — 22
9(x) = cos(f'(z +2))

Furthmore, functions can be translated by a veat@.(5 and a free function can be moved
with the mouse.

Limit Function to Interval

In order to limit a function to an interval [a, b], please use the comnfamdttion (see4.3.1]).

4.2.6 Arithmetic Operations

To enter numbers, coordinates or equati@ghg)(you may use arithmetic expressions with paren-

theses. The following operations are available:

operation input
addition +
subtraction -
multiplication, scalar product * Or space
division /
potentiation " or?3
factorial !
Gamma Funktion gamma( )
parentheses ()
x-coordinate X( )
y-coordinate y( )
absolute value abs( )
sign sgn( )
square root sqrt( )
exponential function exp( )
logarithm (natural) log( )
cosine cos( )
sine sin( )
tangent tan( )
arc cosine acos( )
arc sine asin( )
arc tangent atan( )
hyperbolic cosine cosh( )
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hyperbolic sine sinh( )
hyperbolic tangent tanh( )
antihyperbolic cosine acosh( )
antihyperbolic sine asinh( )
antihyperbolic tangent atanh( )

greatest integer less than or equal | floor( )
smallest integer greater than or equaleil( )
Runden round( )

For example, the midpoint M of two points A and B might be entereMagA+B)/2 . The
length of a vector v might be calculated usirgqgrt(v = *V) .
We see that you can do calculations with points and vectors as well in GeoGebra.

4.3 Commands

With the aid of commands we can produce new and change existing objects. Intersecting two

lines g and h produces a new point, for exam@e= Intersect[g,h] (4.3.9.
A command’s result may be named by entering a label followed.biy our examples =
Intersect[g, h] the new point is name8.

You can also use indices within the names of objedisresp. s, is entered as\_1 resp.
s_AB.

4.3.1 General Commands
Relation

Relation[ object a, objecth shows a message box that tells us the relation of a and b.

This command lets us find out whether two objects are equal, if a point lies on a line or conic,
or if a line is tangent or passant to a conic.

Delete

Delete[ objecl Deletes an object and all its dependents.

4.3.2 Number
Length

Length[ vectoll Length of a vector

Length[ point A] Length of the position vector of A
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Area

Area[ point A, point B, point C, ..] Area of the polygon defined by the given points

Distance

Distance[ point A, point B Distance of two points A and B

Distance[ point A, lined Distance of a point Aand aline g

Distance[ line g, line ] Distance of lines g and h. The distance of intersecting lines is 0.
This function is interesting for parallel lines.

Slope

Slope[ line] Slope of a line. This command also draws the slope triangle whose size may be
changed (see Properti€s1.]).

Radius

Radius[ circle] Radius of a circle

Parameter

Parameter[ parabold Parameter of a parabola (distance of directrix and focus)

FirstAxisLength

FirstAxisLength[ conid Length of a conic section’s principal axis

SecondAxisLength

SecondAxisLength[  conid Length of a conic section’s second axis

Excentricity

Excentricity[ conid Excentricity of a conic

Integral

Integral[  function f, number a, numbei b Definite integral of f(x) from a to b. This com-
mand also draws the area between the function graph of f and the x-axis.

Integrall  function f, function g, number a, numbef Definite integral of f(x)-g(x) from a
to b. This command also draws the area between the function graphs of f and g.

See indefinte integrad.3.11
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LowerSum

LowerSum|[ function f, number a, number b, numbdr ower sum of function f on interval [a,b]
with n rectangles. This command draws the rectangles of the lower sum too.

UpperSum

UpperSum| function f, number a, number b, numbdr upper sum of function f on interval [a,b]
with n rectangles. This command draws the rectangles of the upper sum too.

4.3.3 Angle
Angle
Angle[ vector, vector Angle between two vectors (between 0 and<360

Angle[ line, lingl Angle between the direction vectors of two lines (between 0 ané))360

Angle[ point A, point B, point @ Angle enclosed by BA and BC (between 0 and 36® is
apex.

Angle[ point A, point B, angle alpHa Angle of size alpha drawn from B with vertex A. The
point Rotate[B, A, a] is created too.

Angle[ conid Angle of twist of a conic section’s principle axi4.8.9

Angle[ vector\] Angle between x-axis and vector v

Angle[ point A] Angle between x-axis and position vector of point A

Angle[ numbet Converts a number into an angle (result between 0 and 2pi)

Angle[ polygonl All inner angles of a polygon

4.3.4 Point
Point

Point[ line] Point on line

Point[ conid Point on conic section (e.g. circle, ellipse, hyperbola)
Point[ function Point on function

Point[ vectof Point on vector

Point[ point P, vectory PointP +v
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Midpoint
Midpoint[
Midpoint[

Center
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point A, point B Midpoint of A and B

segment Midpoint of segment

Center[ conid Center of a conic section (e.g. circle, ellipse, hyperbola)

Focus

Focus[ conid (All) foci of a conic section

Vertex

Vertex] conid (All) vertices of a conic section

Centroid
Centroid[

Intersect

Intersect[
Intersect[
Intersect[
Intersect[
Intersect[
Intersect[
Intersect[
Intersect[
Intersect[

Intersect|

polygor] Centroid of a polygon

line g, line | Intersection point of lines g and h

line g, conic ¢ All Intersection points of g and ¢ (max. 2)

line g, conic ¢, number]n n-th intersection point of g and ¢

conic ¢, conic §i  All intersection points of c and d (max. 4)

conic ¢, conic d, number]n n-th intersection point of c and d
polynomial f, polynomial ¢ All intersection points of f and g
polynomial f, polynomial g, number]n n-th intersection point of fand g
polynomial f, line g All intersection points of fand g

polynomial f, line g, number]n n-th intersection point of f and g

function f, function g, point A Intersection point of f and g with initial value A

(for Newton’s method)

Intersect[

function f, line g, point A Intersection point of f and g with initial value A (for

Newton’s method)
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Root

Root[ polynomial{ All roots of polynomial f (as points)
Root[ function f, number i One root of function f with initial value a (Newton’s method)

Root[ function f, number a, numbeil bOne root of function f with on interval [a, b] (regula
falsi)

Extremum

Extremum[ polynomial { All local extrema of polynomial f (as points)

InflectionPoint

InflectionPoint[ polynomial { All inflection points of polynomial f
4.3.5 Vector
Vector

Vector[ point A, point B Vector from Ato B

Vector[ pointl Position vector of a point

Direction

Direction[  line] Direction vector of a line. A line with equatiom: + by = ¢ has direction
(bv _CL)'

UnitVector

UnitVector[ line] Direction vector with length 1 of a line

UnitVector[  vectol Vector with length 1, same direction and orientation as the given vector
(4.39

PerpendicularVector

PerpendicularVector[ line] Perpendicular vector of a line. A line with equation +
by = ¢ has the perpendicular vectar, b).

PerpendicularVector[ vectol] Perpendicular vector of a vector. A vector with coordi-
nates(a, b) has the perpendicular vectorb, a).
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UnitPerpendicularVector
UnitPerpendicularVector| line] Perpendicular vector with length 1 of a line.

UnitPerpendicularVector| vecto] Perpendicular vector with length 1 of a vector.

4.3.6 Segment
Segment

Segment[ point A, point B Segment between two points A and B

Segment[ point A, number § Segment with length a and starting point A. The endpoint of the
segment is created too.

4.3.7 Ray
Ray
Ray[ point A, point B Ray starting at A through B

Ray[ point A, vector J Ray starting at A with direction v

4.3.8 Polygon
Polygon
Polygon[ point A, point B, point C, ..] Polygon defined by the given points

4.3.9 Line
Line
Line[ point A, point B Line through two points A and B

Line[ point A, lined Line through A parallelto g

Line[ point A, vector \ Line through A with direction v

Perpendicular

Perpendicular| point A, line d Line through A perpendicular to g

Perpendicular| point A, vector } Line through A perpendicular to v
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LineBisector

LineBisector| point A, point B Line bisector of the line segment AB

LineBisector]| segmentk Line bisector of the segment s

AngularBisector

AngularBisector[ point A, point B, point § Angular bisector of the angle (A, B, C). Biis
apex of this angle.

AngularBisector[ line g, line | Both angular bisectors of g and h.

Tangent

Tangent[ point A, conic ¢ (All) tangents through Ato ¢
Tangent[ line g, conic ¢ (All) tangents to c that are parallel to g
Tangent] number a, function]f Tangent to f(x) at x=a

Tangent[ point A, function{ Tangent to f(x) at x=x(A)

Asymptote
Asymptote[ hyperbola ¢ Both asymptotes of a hyperbola

Directrix

Directrix[ parabola t Directrix of a parabola

Axes

Axes[ conicd Principal and second axis of a conic section

FirstAxis

FirstAxis[ conic d Principal axis of a conic section

SecondAxis

SecondAxis[ conicd Second axis of a conic section

Polar

Polar[ point A, conic ¢ Polar line of A relative to ¢
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Diameter

Diameter[ line g, conic ¢ Diameter parallel to g relative to ¢

Diameter[ vector v, conic ¢ Diameter with direction v relative to ¢

4.3.10 Conic section
Circle

Circle[ point M, number} Circle with midpoint M and radius r
Circle[ point M, segment]s Circle with midpoint M and radius = Length[s]
Circle[ point M, point A] Circle with midpoint M through A

Circle[ point A, point B, point @ Circle through A, Band C

Ellipse

Ellipse[ point F, point G, number]a Ellipse with foci F, G and principal axis length a. Con-
dition: 2a > Distance[F,G]

Ellipse[ point F, point G, segment sEllipse with foci F, G and principal axis length a = Length[s]

Hyperbola

Hyperbola] point F, point G, number]a Hyperbola with foci F, G and principal axis length
a. Condition:0 < 2a < Distance[F,G]

Hyperbola] point F, point G, segmeni sHyperbola with foci F, G and principal axis length
a = Lengthl[s]
Parabola

Parabola] pointF, lined Parabola with focus F and directrix g

Conic

Conic[ point A, point B, point C, point D, point E Conic section through five points (no four
lie on one line)
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4.3.11 Function
Derivative

Derivative[ function f| Derivative of function f(x)

Derivative[  function f, number h n-th derivative of function f(x)

Integral

Integrall  function f| Indefinite integral for f(x)

See definte integradl.3.2

Polynomial

Polynomial[ functionf yields the expanded polynomial function f.
Example:Polynomial[(z — 3)?] yieldsz? — 6z + 9

TaylorPolynomial

TaylorPolynomial[ function f, number a, numbeill npower series expansion for function
f about the point x=a to order n

Function

Function[ function f, number a, numbel byields a function, that is equal to f on the interval
[a, b] and not defined outside of [a, b]

4.3.12 Arc and Sector

The algebraic value of an arc is its lenght, the value of a sector is its area.

Semicircle

Semicircle[  point A, point B Semicircle above the segment AB.

CircularArc

CircularArc| point M, point A, point B Circular arc with midpoint M between two points
A and B. Note: point B does not have to lie on the arc.

CircumcircularArc

CircumcircularArc| point, point, poink Circular arc through three points
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Arc

Arc[ conic c, point A, point B Conic section arc between two points A and B on the conic
section c (circle or ellipse)

Arc[ conic ¢, number t1, number]t2Conic section arc between two parameter values t1 and t2
for the following parameter forms:

e circle: (r cos(t), r sin(t)), where r is the circle’s radius

e ellipse: (a cos(t), b sin(t)), where a and b are the lengths of the first and second axis

CircularSector

CircularSector[ point M, point A, point B Circular sector with midpoint M between two
points A and B. Note: point B does not have to lie on the arc.

CircumcircularSector

CircumcircularSector| point, point, poink Circular sector through three points

Sector

Sector[ conic ¢, point A, point B Conic section sector between two points A and B on the
conic section c (circle or ellipse)

Sector[ conic ¢, number t1, number]t2Conic section sector between two parameter values
t1 and t2 for the following parameter forms:

e circle: (r cos(t), r sin(t)), where r is the circle’s radius

e ellipse: (a cos(t), b sin(t)), where a and b are the lengths of the first and second axis

4.3.13 Image

Corner

Corner[ image, numbern yields the n-th corner of animage (n=1, ..., 4).
4.3.14 Locus

Locus

Locus[ point Q, point B yields the locus line of point Q that depends on point P. The point P
has to be a point on an object (line, segment, circle, ...).
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4.3.15 Geometric Transformations

If you assign one of the following commands to a new name, a copy of the moved object will
be produced. The commamdirror[A, g] mirrors point A at line g and changes point A's
location. Enterindd = Mirror[A, d] will produce a new point B while A is left unchanged.

Translate

Translate[ point A, vector } Translates point A by the vector v
Translate[ line g, vector ¥ Translates line g by the vector v
Translate[  conic c, vector ¥ Translates conic c by the vector v
Translate[  function c, vector ¥ Translates function f by the vector v

Translate[ polygon P, vector v Translates polygon P by the vector v. New vertices and
segments are created too.

Translate[ image p, vector ) Translates image p by the vector v

Translate[ vectorv, Point p Translates vector v to point p

Rotate

Rotate[ point A, angle pHi Rotates point A by angle phi around the axis origin
Rotate[ vector v, angle phi Rotates vector v by angle phi

Rotate[ line g, angle pHi Rotates line g by angle phi around the axis origin

Rotate[ conic ¢, angle phi Rotates conic section ¢ by angle phi around the axis origin

Rotate[ polygon P, angle phi Rotates polygon P by angle phi around the axis origin. New
vertices and segments are created too.

Rotate[ image p, angle phi Rotates image p by angle phi around the axis origin
Rotate[ point A, angle phi, point B Rotates point A by angle phi around point B
Rotate[ line g, angle phi, point B Rotates line g by angle phi around point B

Rotate[ conic ¢, angle phi, point B Rotates conic section ¢ by angle phi around point B

Rotate[ polygon P, angle phi, point]B Rotates polygon P by angle phi around point B. New
vertices and segments are created too.

Rotate[ image p, angle phi, point]B Rotates image p by angle phi around point B
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Mirror

Mirror[  point A, point B Mirror point A at point B

Mirror[  line g, point B Mirror line g at point B

Mirror[  conic ¢, point B Mirror conic section c at point B

Mirror[  polygon P, point B Mirror polygon P at point B. New vertices and segments are cre-
ated too.

Mirror[ image p, point B Mirror image p at point B
Mirror[  point A, line i Mirror point A at line h
Mirror[ line g, line | Mirror line g at line h

Mirror[  conic ¢, line B Mirror conic c at line h

Mirror[  polygon P, line h Mirror polygon P at line h. New vertices and segments are created
too.

Mirror[  image p, line h Mirror image p at line h

Dilate

Dilate[ point A, number f, point § Dilates point A from point S using the factor f
Dilate[ line h, number f, point B Dilates line h from point S using the factor f
Dilate[ conic ¢, number f, point]S Dilates conic section c from point S using the factor f

Dilate[ polygon P, number f, point]S Dilates polygon P from point S using the factor f. New
vertices and segments are created too.

Dilate[ image p, number f, point]S Dilates image p from point S using the factor f
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Printing and Export

5.1 Printing

5.1.1 Drawing Pad

You find the itemPrint Preview, Drawing Padn the File menu. Here, you can specify title,
author, date and the scale of your print-out (in cm).
Press Enter after any change to update the preview window.

5.1.2 Construction Protocol
There are to ways to open the print preview window of the construction protocol:
¢ In theFile menu,Print Previewyou find the itemConstruction Protocol

¢ In the View menu, open th€onstruction Protocofirst. There you find the iten®Print
Previewin theFile menu.

The second way is more flexible as you may switch on and off the different columns of the
construction protocol here (see meview of the construction protocol).
In the print preview window you can enter titel, author and date.

5.2 Drawing Pad as Picture

You find the itemDrawing Pad as Picturen the File menu,Export Here, you can specify the
scale (in cm) and the resolution (in dpi) of the output file. The true size of the exported image is
shown in the bottom of the window.

Choose out of the followinfprmats

PNG - Portable Network Graphics: This is a pixel graphics format. The higher the resolution
(dpi), the better the quality (300dpi will usually suffice). PNG graphics should not be
scaled subsequently to avoid a loss of quality.

37
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PNG graphic files are well suited for the use on web pages (html) and with Microsoft
Word. Whenever you insert a PNG graphic file into a Word document (rimesaut, Image

from file) make sure that the size is set to 100%. Otherwise the given scale (in cm) would
be changed.

EPS - Encapsulated Postscript:This is a vector graphics format. EPS pictures may be scaled
without loss of quality. EPS graphic files are well suited for the use with vector graphics
programs like Corel Draw and professional text processing systemgTgeé L

The resolution of an EPS graphic is always 72dpi. This value is only used to calculate the
true size of an image in cm and has no effect on the image’s quality.

Note: the transparency effect with filled polygons or conic sections is not possible with
EPS.

5.3 Drawing Pad to Clipboard

You find the itemDrawing Pad to Clipboardn the File menu,Export This copies a screenshot
of the drawing pad to your system'’s clipboard as a PNG picture. This picture can be pasted into
other programs (e.g. a Microsoft Word document).

In Order to export your construction at a certain scale (in cm) please use the menu item
Drawing Pad as Picturen the File menu,Export

5.4 Construction Protocol as Webpage

There are to ways to open the wind@xport Construction Protocol
¢ In theFile menu,Exportyou find the itemConstruction Protocol as Webpage (html)

¢ In theViewmenu, open th€onstruction Protocofirst. There you find the iter&xport as
Webpagen the File menu.

The second way is more flexible as you may switch on and off the different columns of the
construction protocol here (see meview of the construction protocol).

In the export window you can enter title, author and date of the construction and choose
whether you want to export a picture of the drawing pad and the algebra window along with the
protocol.

The exported HTML file can be viewed with any internet browser (e.g. Mozilla, Internet
Explorer) and edited with many word processing systems (e.g. Frontpage, Word).

5.5 Dynamic Worksheet as Webpage

In the File menu,Exportyou find the itemDynamic Worksheet as Webpage (html)
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In the export window you can enter title, author, date and some text above and below the dy-
namic construction (e.g. a description of the construction and some exercises). The construction
itself may be included directly into a webpage or opened by clicking a button.

Note: don’t take too big values for the width and height of the dynamic construction in order
to make it fully visible in the internet browser.

Three files are created when exporting a dynamic worksheet:

1. html file, e.g.circle.html- this file includes the worksheet itself
2. ggb file, z.B.circle_worksheet.ggbthis file includes your GeoGebra construction
3. geogebra.jar this file includes GeoGebra and makes your worksheet interactive

All three files - e.g.circle.html circle_worksheet.ggandgeogebra.jar- have to be in one
folder (directory) to let the dynamic construction work. Of course, you may copy all three files
to another folder too.

Note: The exported HTML file - e.gcircle.html- can be viewed with any internet browser
(e.g. Mozilla, Internet Explorer). In order to let the dynamic construction work, Java has to
be installed on the computer. You can get Java ftdtp://www.java.conwithout charge. If
you want to use your worksheet in your school’s computer network, ask your local network
administrator to install Java on the computers.

You can also edit the worksheet'’s text with many word processing systems (e.g. Frontpage,
Word) by opening the exported HTML file.
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Options

Global options may be changed in the meapiions To change object settings, please use the
context menugd.1.1).

6.1 Point Capturing

Point capturing to grid

6.2 Angle unit

Determines whether angles are displayed in degnear fadian (ad ).
Input is always possible in both ways (degree and radian).

6.3 Decimal Places

Adjustable decimal places: 0,1, ...,5

6.4 Point style

Determines whether points are displayed as dots or crosses.

6.5 Graphics

Determines the quality of graphic output in the geometry window.
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6.6 Fontsize

Determines the font size in points (pt).

6.7 Language

GeoGebra is multilingual. Here you can change the current language setting. This affects all
inputs including command names and all outputs.

6.8 Drawing pad

Opens a window where properties of the drawing pad (axes, coordinate grid, etc.) may be set.
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drawing pad37
Protocol,11
protocol
export,38

Radius
command26
Ray
command30
Ray through two points
mode,14
redefine11
Relation
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command?25
mode,12
Renamel0
Root
command?29
Rotate
command35
Rotate around point
mode,12
Rotate object around point
mode,18

scalar product24
SecondAxis
command31
SecondAxisLength
command26
Sector
command34
sector,33
Segment
command30
segment
convert to line: redefing, 1
Segment between two points
mode,14
Segment with given length from point
mode,14
Semicircle
command33
mode,16
show,10
Show / hide label
mode,12
Show / hide object
mode,12
simplify
polynomial,33
Size,10
Slider
mode,17
Slope
command26
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square root24

Tangent
command31
Tangents
mode,15
TaylorPolynomial
command33
Text
mode,18
Trace,10
transformations
geometric 35
Translate
command35
Translate object by vector
mode,18
transparent
image,20
trigonometric functions24

UnitPerpendicularVector

command30
Unit\Vector

command?29
UpperSum

command?27

value
change21
Vector
command?29
vector,22
Vector between two points
mode,13
Vector from point
mode,14
Vertex
command?28
visual style
copy,13

worksheet
dynamic,38



46

XAXis, 23
YAXis, 23

zoom,11

Zoom in
mode,12

Zoom out
mode,12
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